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Prop. Directional Control Valve
Operation Manual Series DFplus Pilot Operated

A WARNING — USER RESPONSIBILITY

FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DESCRIBED
HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND PROPERTY
DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and
authorized distributors provide product or system options for further investigation by users having
technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection
of the system and components and assuring that all performance, endurance, maintenance,
safety and warning requirements of the application are met. The user must analyze all aspects
of the application, follow applicable industry standards, and follow the information concerning
the product in the current product catalog and in any other materials provided from Parker or its
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or
system options based upon data or specifications provided by the user, the user is responsible for
determining that such data and specifications are suitable and sufficient for all applications and
reasonably foreseeable uses of the components or systems.

Offer of Sale

Please contact your Parker representation for a detailed "Offer of Sale”.
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1. Introduction
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Ordering Code

eILBEEIL LT LV LI L) LU

Funct|on Flow
(see (see
catalogue) catalogue)

Spool Pilot
position con-
on power nection

down (see
catalogue)

Direct. Size
control
valve
Code Size
3 |NG10/CETOP 05
4 |NG16/CETOP 07
8 |NG25/CETOP 08
9 |NG25/CETOP 08
11 |NG32/CETOP 10
Code Spool position
on power down
av [ fe] o]
P T
A B
B ([o] [ofe]
P T
A B
P T

" Approx. 10 % opening, only zero lapped spools.

2 For overlapped spools.
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Seal Command Elec-

Valve Design

signal  tronic option series
option
Code Valve option
0 Standard for
spool B, E, R
Hybrid valve 24V
L | normaly closed for
spool code Z
Code | Electronic option
0 6 + PE
5 11+ PE
7 6 + PE w. Enable
Code | Signal Function
B +10V [ 0..+10V ->P-B
E + 20 mA |0...+20 mA -> P-B
K +10V [ 0..+10V ->P-A
S [4..20mA|[12..20 mA -> P-A
Code Seal
N NBR
\Y FPM
H for HFC fluids

Parker Hannifin Corporation
Hydraulics Group
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Name Plate

& Made in Germany @
:iarker

RTIONAL 1]

D41FPEOTFBUNBOO3S

Code: KV

350 bar max. PAB T x
"35 bar max. y

‘ nominal pressure
hydr. spool symbol
order code

Parker D*1FP proportional directional control valves
have an integral electronic. Different flow sizes,
power-down positions as well as command signal
options are available to achieve an optimal adaption
for different applications.

Characteristics of Valve Driver

The described integral electronic driver combines

all necessary functions for the optimal operation of

the valve. Thanks to its excellent dynamic the valve

is usable within closed loop control applications.

The most important features are:

* high dynamic actuator principle with special
designed electronic driver

* closed loop controlled pilot valve and main spool

* constant current actuator control with overcur-
rent shutoff

* excellent properties for response sensitivity and
temperature drift

» differential input stage with various command
signal options

» diagnostic output for spool stroke/overcurrent
state

3
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Block Diagram of Integral Electronics
Code 0 (6+PE)

‘r Parametrizing T
‘ interface ‘
0 '
®
0.x10V
4..20 mA
+20 mA
diagnostic
spool stroke
0..x10V

\
g%g)i o
°

22..30V=

Code 5 (11+PE)

+6..30 V=
‘r Parametrizing
‘ interface
Gh
0..x10V
4..20 mA
+20 mA j

uc

d\agnostlc
sool stroke

0..x10V

supply
voltage

22.30V=

Code 7 (6+PE with enable)

+5...30 V
‘r Parametrizing
‘ interface
0
®
0..x10V
4..20 mA
+20 mA !
diagnostic
spool stroke

0..x10V

1]

@ .

6%8) ———— @—
.

22..30V=
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Technical Data

General

Design Servo proportional directional control valve, pilot operated

Actuation VCD®-actuator

Size NG10 (CETOP 05)]NG16 (CETOP 07)[NG25 (CETOP 08)NG32 (CETOP 10)

D31 D4 | psi/po1 | D111
Mounting Interface DIN 24340/ 1SO 4401 / CETOP RP121 / NFPA
Mounting position unrestricted
Ambient temperature [°C]| -20...+50
MTTF, value [years]| 50
Weight [kg] 11.3 [ 14.2 [ 235 64.5

Vibration resistance [a]

10 Sinus 5...2000 Hz acc. IEC 68-2-6
30 Random noise 20...2000 Hz acc. IEC 68-2-36
15 Shock acc. IEC 68-2-27

Hydraulic

Max. operating pressure [bar]

Internal pilot drain P, A, B, X 350;T,Y 35
External pilot drain P, A, B, T, X 350;Y 35

Fluid Hydraulic oil according to DIN 51524 ... 535, other on request
Fluid temperature [°C]| -20...+60 (NBR: -25...+60)
Viscosity
permitted [cSt)/[mm2/s] | 20...400
recommended [cSt}/[mm2/s]| 30...80
Filtration 1SO 4406 (1999); 18/16/13
Electrical
Duty ratio [%]| 100
Protection class IP65 in accordance with EN 60529 (with correctly mounted plug-in connector)
Supply voltage / ripple [V]] 22...30, ripple < 5 % eff., surge free
Current consumption max. [A]| 3.5
Pre-fusing [A]| 4.0 A medium lag
Input signal  Code K (B) voltage [V]|+10...0...-10, ripple < 0.01 % eff., surge free, 0...+10 V P—>A (P—B)
Impedance [kOhm]| 100
Code E voltage [mA]| +20...0...-20, ripple < 0.01 % eff., surge free, 0...+20 mA P->B
Impedance [Ohm]| 250
Code S current [mA]| 4...12...20, ripple < 0.01 % eff., surge free, 12...20 mA P—>A
Impedance [Ohm]| 250
< 3.6 mA = enable off, > 3.8 mA = enable on acc. NAMUR NE43
Input Capacitance typ. [nF]| 1
Differential input max. [V]| 30 for terminal D and E against PE (terminal G)
Code 0 11 for terminal D and E against OV (terminal B)
Code 5 [V]| 30 for terminal 4 and 5 against PE (terminal < )
11 for terminal 4 and 5 against OV (terminal 2)
Code 7 [V]| 30 for terminal D and E against PE (terminal G)
Enable signal Code 5/7 [V]] 5...30, Ri = > 8 kOhm
Diagnostic signal [V]| +10...0...-10/ +12.5 V, rated max. 5 mA
EMC EN 61000-6-2, EN 61000-6-4
Electrical connection
Code 0/7 6 + PE acc. EN 175201-804
Code 5 11 + PE acc. EN 175201-804
Wiring min.  Code 0/7 [mm2]| 7 x 1.0 (AWG16) overall braid shield
Code 5 [mm?]| 8 x 1.0 (AWG16) overall braid shield
Wiring length max. [m]| 50
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2. Safety Instructions

Please read the operation manual before instal-
lation, startup, service, repair or stocking! Paying
no attention may result in damaging the valve or
incorporated system parts.

Symbols

This manual uses symbols which have to be fol-
lowed accordingly:

& Instructions with regard to the warranty

Instructions with regard to possible dam-
aging of the valve or linked system com-
ponents

(> Helpful additional instructions

Marking, Name Plates

Instructions applied on the valve, i.e. wiring dia-
grams and name plates, must be observed and
maintained legibly.

Work at the Valve

Workingsinthe area of installation, commissioning,
maintenance and repair of the valve may only be
allowed by qualified personnel. This means persons
which have, because of education, experience and
instruction, sufficient knowledge on relevant direc-
tives and approved technical rules.

3. Important Details
Intended Usage
This operation manualis valid for proportional direc-

Common Instructions

We reserve the right for technical modifications of
the described product. lllustrations and drawings
within this manual are simplified representations.
Due to further development, improvement and
modification of the product the illustrations might
not match precisely with the described valve. The
technical specifications and dimensions are not
binding. No claim may resulting out of it. Copyrights
are reserved.

Liability

The manufacturer does not assume liability for
damage due to the following failures:

* incorrect mounting / installation
¢ improper handling
* lack of maintenance
* operation outside the specifications
Do not disassemble the valve! In case of
suspicion for a defect please contact Parker.
Storage

In case of temporary storage the valve must be
protected against contamination, atmospheric ex-
posure and mechanical damages. Each valve has
been factory tested with hydraulic oil, resulting in
protection of the core parts against corrosion. Yet
this protection is only ensured under the following
conditions:

Outdoor storage or within sea and tropical

climate will lead to corrosion and might dis-

able the valve!

tional control valves DFplus pilot operated series. | Storage Storage requirements
Any different or beyond it usage is deemed to be | period ge requ
as not intended. The manufacturer is not liable for 15 " constant humidity < 60 % as well
warranty claims resulting from this. months | - constant temperature < 25 °C
6 months varying humidity as well as
varying temperature < 35 °C
D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015
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4. Mounting / Installation
Scope of Supply

Please checkimmediately after receiving the valve,
if the content is matching with the specified scope
of supply. The delivery includes:

* valve

* operation manual

The central connector assembly has to be ordered
separately and is not included in the delivery.

> Please check the delivery immediately after
receiving the shipment for apparent damages
due to shipping. Report shipment losses at
once to the carrier, the insurance company
and the supplier!

Mounting

* Compare valve type (located on the name plate)
with part list resp. circuit diagram.

¢ Unrestricted mounting position.

» Verify the mounting surface for the valve. Uneve-
ness of 0.01 mm/100 mm, surface finish of 6.3
um are tolerable values.

> Keep clean valve mounting surface and work
environment!

* Remove protection plate from the valve mounting
surface

* Check the proper position of the valve ports and
the O-rings.

* Mounting bolts:
D31FP: 4 pcs. M6x40
D41FP: 2 pcs. M6x55, 4 pcs. M10x60
D81/91FP: 6 pcs. M12x75
D111FP: 6 pcs. M20x90
use property class 12.9, ISO 4762

> Parker offers bolt kits:

D31FP: BK385, D41FP: BK320, D81/91FP:
BK360, D111FP: BK 386

* Tighten the bolts crisscross with the following
torque values:
D31FP: 13.2 Nm, D41FP: 13.2/63 Nm,
D81/91FP: 108 Nm, D111FP: 517 Nm
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Insufficient condition of the valve mounting
surface migth create malfunction! Incorrect
mounting resp.bolttorque may resultin abrupt
leakage of pressure fluid on the valve ports.

Operation Limits

The valve may be operated within the determined
limits only. Please refer to the “technical data“ sec-
tion as well as to the “characteristic curves” in the
catalog.

Follow the environmental conditions! Unal-
lowable temperatures, shock load, aggresive
chemicals exposure, radiation exposure, il-
legal electromagnetic emissions may result
in operating trouble and may lead to failure!
Follow the operating limits listed in the
“specifications” table!

Pressure Fluids

The following rules applies for the operation with
various pressure fluids:

This information serves for orientation and
does not substitute user tests among the
particular operating conditions. Particularly
no liabiliy for media compatibility may be
derived out of it.

Mineral oil: usable without restriction.
HFC: choose the right seal option.

For operation with the following pressure fluids
please consult Parker:

HFA oil-in-water emulsion
HFB water-in-oil emulsion
HFD unhydrous fluids (Phosphor-Ester)

> For detailed information concerning pressure
fluids note VDMA-document 24317 as well as
DIN 51524 & 51502.

Special gaskets may be available depending on
the utilized fluid.
In case of insecurity please consult Parker.

Parker Hannifin Corporation
Hydraulics Group
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Electrical Connection

The electrical connection of the valve takes place
by one common cable, which is coupled to the
integrated electronic driver by a central connector
assembly.

7/8-20

3
)
x
\,
o

J28.6
f
T
I
|

The connection Code 0 as well as Code 7 requires
a 6 + PE female connector EN 175201-804.

> The female connector has to be ordered
separately under article nr. 5004072.
A female connector with metal housing is
required! Plastic made models may create
function problems due to insufficient EMC-
characteristics.

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible,
7 conductors, overall braid
shield

Cross section min. AWG16

Outer dimension 8...12mm

Cable length max. 50 m

> For cable lengths > 50 m consult Parker.
The connection cable is coupled to the female
connector by solder joints.

Skinning lengths for the connecting cable:

M

——
——
—————
——

The connection Code 5 requires a 11 + PE female
connector EN 175201-804.

max. 91

> The female connector has to be ordered
separately under article nr. 5004711.
A female connector with metal housing is
required! Plastic made models may create
function problems due to insufficient EMC-
characteristics.

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible,
8 conductors, overall braid
shield

Cross section min. AWG16

Quter dimension 12...15mm

Cable length max. 50 m

g For cable lengths > 50 m consult Parker.

The connection cable is coupled to the female
connector by crimp contacts.

Skinning lengths for the connecting cable:

I

—————————
—
——
———

g For the workmanlike termination of the crimp
contacts the tool # 932 507-001 — supplier:
Hirschmann — is required.

A Do notdisconnect cable socket undertension!

The shielding has to be assembled according the
outline below:

shield

contact metal ring seal insert backshell
insert nut
D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015
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The backshell nut of the cable gland has to be
tighten with a suitable tool. The target value for the
tightening torque is 4 Nm. Tighten the cap nut with
a torque of approx. 5 Nm after attaching the female
connector on the socket outlet.

AN

VAN

Incomplete tightening of backshell nut resp.
cap nut may result in automatic release of the
connection as well as degradation of the
water tightness.

Follow the “instructions for use” for installation
of female connectors made by other kind of
brands!

The cable connection to the female connector
has to take place by qualified personnel! A
short between individual conductors resp. to
the connector housing , bad soldering as well
as improper shield connection may result in
malfunction and breakdown of the valve.
The mounting surface of the valve has to be
carefully tied to the earth grounded machine
frame. The earth ground wire from the valve
connecting cable as well as the cable shield
have to be tied to the protective earth terminal
within the control unit. It is necessary to use
a low ohmic potential connection between
control unit and machine frame to prevent
earth loops (cross section AWG 6).

D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015

Electrical Interfacing
Supply Voltage

The supply voltage for the valve has to cover the
range of 22...30 V. The residual ripple may not
exceed 5% eff.

A

The applied power supply must comply to the
relevantregulations (DIN EN 61558) and must
carry a CE-mark. The operating voltage for
the valve must be free of inductive surges. Do
not exceed the max. value of 30V! Non-ob-
servance of this rule may resultin permanent
damaging of the valve.

The increased inrush current of the valve
should be considered when selecting the
power supply. A stabilized power supply with
overcurrent limiting feature should not be
used. Due to the inrush current of the valve
the current limit circuit may respond prema-
turely and create problems during energizing
of the supply voltage.

The operation of the valve is blocked if the
supply voltage polarity is interchanged.

Each valve requires a separate pre-fuse of 4
Amptime lag.Non-observance of this instruc-
tion may create irreparable damage of valve
resp. incorporated system parts.

10
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Wiring

Code 0, 6 + PE acc. EN 175201-804

Diagnostics

Power supply

valve stroke

0..x10V

0..x10V
4..20m A
0..220m A

Command

Code 7,6 + PE acc. EN 175201-804 + enable

Diagnostics
valve stroke

Power supply

0..x10V

0..x10V
4..20 mA
0..x20 mA

Command

D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015

Code 5,11 + PE acc. EN 175201-804

5..30V

Command

0..x10V
4..20 mA
0...220 mA

0 +
Enable i

Power supply

Diagnostics
valve stroke

0..x10V

Pin 3 and 8 internally connected
Pin 9 and 11 internally connected
Pin 10 not connected

Parker Hannifin Corporation
Hydraulics Group
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Enable input (only for Code 5/ 11+PE as well
as Code 7/ 6+PE)

A signal voltage enables the actuator drive of the
valve. Continuous operation of the valve requires a
permanentvoltage 5...30V (i.e. the supply voltage).
In case of disabling the signal the valve will reach its
power down position spring-actuated independently
from the command signal value.

The enable function represents no safety
arrangement against unwanted valve opera-
tion in terms of rules for accident prevention!

Command signal input

The spool stroke behaves proportional to the com-
mand signal amplitude.

The command inputsignal needs to be filtered
as well as free of inductive surges and
modulations. Due to the sensitivity of the valve
a high signal quality is recommended, this will
prevent malfunction.

% Incorrect signal amplitude levels may disturb
the functionality and can damage the valve.

The option 4...20 mA uses the “3.6 mA* con-
dition as breakdown-information. This means
the presence of an evaluable failure informa-
tion if the input signal line is interrupted. In
this case the actuator drive will be switched
off. The drive will switch on when the input
signal reaches a value of 3.8 mA, it switches
off when the command falls below 3.6 mA.
This determination follows the NAMUR-
specification NE43.

NAMUR is an association of users of process
control technology.
Diagnostics output

A diagnostics signal is available. Its voltage repre-
sents the operating condition of the valve.

The output may drive a load of max. 5 mA.
Exceeding of this limit leads to malfunction.

D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015

Co%:gzn d Cor_nmand Function VCD Diagnostic
signal signal actuator signal
o.+10v | [X] on | 0..-10V
B o.-10v | [1] on | 0.+10V
Overload E off ca. 125V
0...+20 mA on 0..-10V
E |o.-20mA| [[] on | 0..+10V
Overload E off ca. 125V
o..+tov | [ on | 0..+10V
K 0..-10V on | 0..-10V
Overload E off ca. 125V
4..12mA | [X] on | 0..-10V
12..20mA| [[]] on | 0.+10V
s
0..36mA| [o] off Cg;'ﬁ ;fi’/k’
Overload E off ca.12.5V

5. Operating Instructions
Preferred Hydraulic Initial State

For valves with zero lap spools, distinction
must be made between hydraulic neutral
position and power-down position. Neutral
position is taken at neutral input signal, cor-
responding to zero position of the hydraulic
symbol. When the valve is switched off — no
supply voltage, no enable, current signal
(code S) < 3,8 mA — zero lap valves take the
power down position (approx. 10 % opening)
according to the ordering code. For valves
with overlap spools, neutral position and
power down position are the same (zero
position).

Supply pressure mustbe ensured before valve
is energized.

12 Parker Hannifin Corporation
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Solenoid Current Monitoring

If the actuator current time interval exceeds 10
seconds, the actuator is switched off to prevent
overheating. For normal operating conditions this
state will not reached, but it may occur with a con-
taminated sluggish valve.
In this case the reason for the contamination
should be repaired (hydraulic fluid exchange,
filtration review, valve flushing).
The overcurrent shutoff condition may be resetted
by the actions below:
Code 0: Temporary disconnection of the supply
voltage.
Temporary disconnection of the enable
signal.
Temporary disconnection of the enable
signal.
> Theshutoffofthe VCD actuator due to overload
will be signaled via the diagnostics output.

Code 5:

Code 7:

ProPxD parameterizing software

The ProPxD software permits comfortable param-
eter setting for the module electronic.Viathe clearly
arranged entry mask the parameters can be noticed
and modified. Storage of complete parameter sets
is possible as well as printout or record as a text
file for further documentation.

The PC software can be downloaded free of charge
at www.parker.com/euro_hcd - see page “Support’
or directly at www.parker.com/propxd.

Please check periodical for updates.

Hardware requirements

¢ PC with operating system from Windows® XP
upwards

* Interface RS232C

¢ display resolution min. 800 x 600

e connection cable between PC and electronic
module

* storage requirement approx. 40 MB

> If your PC has no serial interface according
to RS232 standard you require in addition an
USB-RS232 adapter.

D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015

Cable Specification

Attention! The valve electronic provides no
USB interface, but can only be parametrized
via an RS232C connection. Therefore the
usage of USB standard cables is not allowed
and may resultin damaging of valve resp. PC.

Parametrizing
Ordering code: 40982923

PC side connection

valve side connectior

SubD
9 pole
female plug

5 pole
male plug

Parametering interface

Plug for
parametering interface —

The cover plug has to be re-installed after
completion of the parametrizing work.

Parker Hannifin Corporation
Hydraulics Group
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Program installation

Please check before installation if the above hard-
ware requirements are met. If your PC has already
stored an older version of the “ProPxD” program,
it has to be deinstalled by using the Windows® -
system control feature.

Program installation sequence:

* terminate the execution of other programs
¢ execute the file “setup.exe”

» follow the instructions on the screen

Answer the question, if an older version should be
overwritten, with “ok”. During the installation you
may change destination drive resp. installation
path, if needed.

Please answer “ok” if at the end of the installation
the program reports any system information. After
successful installation the desktop display shows
the ProPxD icon for starting the program.

Software Operating
Brief instruction for first startup:
¢ Connectthevalve electronicto the supply voltage.

Connect the valve electronic to a PC via the
parametrizing cable.

Start the operating program.

After displaying the program resp. data base
version a program window opens and the con-
nected valve will be automatically identified
(possibly a manual identification via the button
“Receive all’ is necessary).

Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”.

The valve specific default parameters are already
available within the parameter table.

Parameter changes are possible via mouse or
the arrow buttons on the bottom left within the
program screen, also the parameter values may
be edited via the keyboard.

Modified parameters will be stored viathe “Enter”
key or via the button “Update list”.

Parameters have to be nonvolatile stored on the
valve via the button “save parameter”.

The chosen parameters may be optionally stored
onthe PC viathe “File”-menu with the menuitem
“Save as”, data retrieving is always possible via
the function “Load file”
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Extended functions:

The user software is shared into 2 parameter
ranges:

basic mode

expert mode

For normal startup the basic mode is sufficient. It
permits the setting of all application specific pa-
rameters to match the valve function with the task
setting.

In case of special applications the valve parameters
may be adapted via the expert mode. The operating
mode may be selected from the “Options”- menu
and remains after terminating and re-start of the
program.

Changing of expert parametersis only permit-
ted for qualified personnel. Incorrect settings
may lead to malfunction! In case of parameter
changes shut the drive down!

To prevent an unauthorized access for the expert
mode, a pass word is requested. The name is
“parker” and cannot be changed. Thus additionally
to the button “Default” for loading of the default
parameters, the button “Send parameter” appears
in the “Expert’-operating mode. This button trans-
mits only the setting of one single parameter to
the connected valve. Thus a quick tuning of single
parameters is permitted during the setup.

> A horizontal bar graph readout between
the communication buttons shows the data
transfer state.

Because the ProPxD program has also
without connection to the valve functionality,
a manual pre-selection of the parameters is
possible. After selection of the valve type via
the menu “Options” the parameters may be
set and stored for later transmission.

Note the design series while selection of the
valve!

The “File” menu provides the functions “Printer
setup”, “Print preview” and “Print”. The print pre-
view includes the option for parameter set storage
as text file (format.txt) prior to further processing.
The “Options” menu provides also the selection of
the RS232 interface port via the menu item “Port”.
Via the menu item “Load file” previously stored
parameter sets may be loaded.

=

14 Parker Hannifin Corporation

Hydraulics Group



Prop. Directional Control Valve
Operation Manual Series DFplus Pilot Operated

LED flashing signals of the valve electronics

enable valve OK: approx. 0.5 Hz (slowly, green)
disable valve OK: approx. 1 Hz (fast, green)
valve error: approx. 10 Hz (very fast, green)

Closer information can be can be displayed via
the ProPxD Parametrier software.

Error code

I%:;;:;i;::)e Error description
0 no errors
1 over current
2 cable break command signal
4 cable break feedback signal
8 undervoltage error
16 bus communication error
32 hardware failure

D_1FP 5715-666 KS30 UK.INDD RH 08.04.2015
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Series DFplus Pilot Operated

Adjustment parameters

The available parameters may be divided into S-parameters
multiple groups and are characterized by different  P-parameters

letters:

J-parameters

Parameter overview for basic mode

o . Parameter Range Default
Parameter Description Unit ) Comment
from up to Setting
P1 Zero adjust % -90.0 90 0.0
P3 MAX channel A % 50.0 100.0 100.0
P4 MAX channel B % 50.0 100.0 100.0
P7 MIN channel A % 0.0 50.0 0.0
P8 MIN channel B % 0.0 50.0 0.0
1=x10V .
E17 option command - 2= 220 mA 1= 10V | Only displayed,
i not adjustable
=4-20m
0(xtoVv/
. code SO only,
E19 cable break detection _ 0 +20 mA) 0/ only displayed,
command
1 (4...20 mA) not adjustable
E25 MIN operating threshold|0.01 % 50 200 100

Individual Description of Basic Parameters

P1

P3

MAX +

P4

MAX -

P7

MIN +

P8

MIN -

E17

option command
E19

cable break detection
command

E25

operating threshold

Adjustment of zero position shifting (offset).

To compensate for unbalances.

Adjustment of maximum signal span for positive output signal.

To match the command signal span to the valve operating range.
Adjustment of maximum signal span for negative output signal.

To match the command signal span to the valve operating range.
Adjustment of stroke step for valve side A at 0.1% command signal.
To compensate for the overlap of the valve spool.

Adjustment of stroke step for valve side B at 0.1% command signal.
To compensate for the overlap of the valve spool.

Adjustment of the command signal option.

To match the command signal input to the input signal mode.
Adjustment of the operating mode for the command cable break
detection. To turn on resp. off of the cable break detection of the
command signal at a selected command signal option of 4...20 mA.
Adjustment of the MIN operating threshold.

To match the response sensitivity for the MIN-stroke step.
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Prop. Directional Control Valve
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Overview for additional expert mode parameter

Parameter

J8

J9

J12

Description

Min supply voltage
supervision
Relay time out off range
min supply voltage

Errorhandling

Parameter Range
from up to

\ 17 28 18

Default
Setting

Unit Comment

ms 0 3200 1000

0= no fault acknowl-
edgment necessary;
255 = fault acknowledg-
ment necessary;
no fault acknowl-
edgment + Fault
report about diag-
nosis;
1023 = fault acknowledg-
ment + Fault report
about diagnosis

768 =
768

Individual description of additional expert parameters

J8

Min supply voltage
supervision

J9

Relay time out off range
min supply voltage

J12
Errorhandling

Adjustment of the minimal supply voltage:
Below this supply voltage the valve switches off with an error message.

Adjustment of the runtime monitoring:

The supply voltage must be at least constantly before the valve is ready
for operation.

Adjustment of the fault response or report:

0 = no fault acknowledgment necessary

255 = fault acknowledgment necessary

768 = no fault acknowledgment + Fault report about diagnosis

1023 = fault acknowledgment + Fault report about diagnosis
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Prop. Directional Control Valve
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Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure messages.

Failure messages and corrective actions:

Failure message

Description/corrective action

The Com Port is not available!

Unable to open COM port

There is no module/valve
connected or the communica-
tion is disturbed! Please check
also the interface!

Wrong password
Wrong input

Keep the entered parame-
ters?

The chosen module/valve
isn’t the same as the connec-
ted hardware. Attention! Unsa-
ved parameters will be lost.

The chosen hardware isn’t
the same as the connected
module/valve.

Attention! Factory settings
will be changed! Transmit
anyhow?

file name.pxd already exists.
Do you want to replace the
file?

Terminate the other program, or quit the message and select ano-
ther RS-232 port via the menu “Options > Port”. Afterwards recon-
nect the parametrizing cable.

Com port is not available. Quit the message and select another
RS-232 port via the menu “Options > Port”. Afterwards reconnect
the parametrizing cable.

No data exchange possible. Either the electronic has been remo-
ved, the port is mismatched, or the connection will be disturbed by
strong electrical fields. Check if the Com port is set for “9600, 8, 1.
none, none” via the menu “Options > Port”.

Retype the password, notice the exact spelling (case sensitivity).

An unvalid character or a value outside the permitted range has
been used at parameter entry.

During parameter loading from the electronics memory the preset
parameters from the left hand screen display may be rejected or
maintained.

In principle, parameters dedicated to a type which deviates from
the connected valve may be edited. However, for data transmitting
the correct valve has to be connected. If parameters will be loaded
from a valve which deviates from the selected one, the parame-
ters from the left hand side screen display of the program will be
overwritten.

The wrong valve type has been selected from the database, afte-
rwards the function “send all” has been executed.

Default parameters has been read out from the database instead
from the valve via the function “receive all”.

The file name already exists within the indicated directory. Select
another name, another directory or overwrite the existing file with
“OKH-

Air Bleeding of Hydraulic System

During initial startup, after an oil change as well as
after the opening of lines or valves the hydraulic
system must be air bleeded.

Filter

The function and lifetime of the valve are strongly
affected by the cleanliness of the fluid.

purity level class of 18/16/13 acc. 1SO4406 is
required.
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Flushing

It is recommended to flush the pipelines by short
circuitingthe pressure and returnlines. This prevents
the installation dirt from entering the valve.

18 Parker Hannifin Corporation

Hydraulics Group



Prop. Directional Control Valve

Operation Manual Series DFplus Pilot Operated

6. Trouble Shooting

Basis of troubleshooting is always a systematic Troubleshooting in a hydraulic system re-

approach. quires detailed knowledge about function
For suspect of a sluggish spool the valve may and construction of t.he system. Therefore
be flushed with clean pressure fluid. the work may exclusively be performed by

qualified personnel.

malfunction at hydraulic load runtime
- generally no function
- high frequent oscillation
- low frequent oscillation
- one way operation only
- speed variations at unchanging command
- different speeds depending on travel direction
- speed too low
- drifting without command
- poor dynamic
possible reasons for malfunction corrective actions
X hydraulic pump resp. motor defective replace hydraulic pump resp. motor
X X[X|X][X]|X X |drive overloaded reduce pressure resp. speed, increase valve size
X X X | X[X]X]| X[ X [valve contaminated clean pressure fluid, filter / flush valve
X X X [hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature
X X[ X too low oil level within tank refill pressure fluid
X[X]X filter contaminated replace filter
X X XX supply voltage too low keep supply voltage range
X supply voltage carries too much ripple reduce ripple
X X X command signal too low increase command signal
X command signal carries too much ripple reduce ripple
X X center position adjustment incorrect check center position adjustment
XX X XX contacts of central connector contaminated clean contacts / replace plug
X feed cable interrupted fix feed cable
XX XXX XX wiring sequence incorrect correct wiring sequence
X X feed cable without shielding change cable grade
X pilot pressure too low or failed increase pilot pressure to min. 20 bar
X XX pilot pressure too low increase pilot pressure to min. 20 bar
X |pilot pressure too low increase pilot pressure to min. 50 bar
8. Accessories / Spare Parts Please direct technical product enquiries to:
Accessories Parker Hannifin
The following accessories are available forthe valve  Manufacturing Germany GmbH & Co. KG
series DFplus pilot operated: Hydraulic Controls Division Europe
Bolt kit Gutenbergstr. 38
) 41564 Kaarst, Germany
D31FP order!ng code BK385 Tel.: (+49) 181 99 44 43 0
Da1FP ordering code BK320 E-mail: valveshcd @ parker.com
D81/91FP ordering code BK360
D111FP ordering code BK386 .
) Hotline in Europe
Female connection
Code 0: 6+PE  ordering code 5004072 Phone: 00800-2727-5374

Code 5: 11-PE ordering code 5004711
Code 7: 6-PE  ordering code 5004072

Spare Parts
Seal kit NBR
D31FP ordering code SK-D31FP
D41FP ordering code SK-D41FP
D81FP ordering code SK-D81FP

D91FP ordering code SK-D91FP
D111FP  ordering code SK-D111FP
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